Why do citation styles matter?

Any academic research project must include accurate documentation of the resources consulted. This means providing information about your sources so your reader can locate them. If you examine articles in research journals, you’ll notice that they always include a list of references, with publication information.

Documentation in research projects has two basic features:

1. **Works Cited List**: At the end of your paper or presentation, include a list of the resources you used. The list must be on a separate page at the end of your paper with the title “Works Cited” centered at the top of the page. Each entry, or citation, in the list provides information about the individual source. Citations are listed in alphabetical order, starting with the author’s last name. If a source has no author, the entry is alphabetized by title. Citations are double-spaced with hanging indents. There are specific rules for punctuation and italics in a Works Cited list, illustrated by the examples in this guide.

2. **In-Text References**: Each time you refer to a source in the text of your paper, include the last name of the author or the first few words of the title of the source (enough to identify it in your list of Works Cited) and the specific page number, if applicable, as close to the paraphrase or quotation as possible. (See the section on In-Text References for examples.) These references lead your reader to the appropriate entry in your Works Cited List.

How can this guide help me?

This brief guide provides examples in the MLA style for information sources most commonly used by DMACC students. It should always be used in conjunction with the 7th edition of the *MLA Handbook for Writers of Research Papers* and information provided by DMACC instructors. Appropriate page numbers from the handbook are documented with each example in this guide. You may also want to visit the MLA website at http://www.mla.org. Finally, don’t forget—your librarians are always ready to help with citation questions!

Contents

- **Formatting Your Paper**
  - Formatting Your Paper (2-5)
  - Sample Paper (6)
- **In-Text References** (7-8)
- **Works Cited Page** (9-10)
- **References**
  - Books (11-13)
  - Articles (14-15)
  - DMACC Library Databases (16-18)
  - Web Sites (19-22)
  - Interviews (23)
  - Visual Art & Graphics (24-26)
  - Other Resources (26-27)
- **Citation Tools**
  - Citation Tools Overview (28-29)
  - NoodleTools (30-38)
  - Word 2013 (39-47)
- **Credits** (48)
What should my final paper look like? (115-122)

The MLA Handbook recommends that all research papers adhere to certain formatting guidelines.

These include:

- Use 1 inch margins around the text of your paper (top, bottom, left, and right).
- Double-space the entire paper, including quotations and the works cited page.
- Indent the first line of all body paragraphs by 1/2 inch.
- Use a basic, readable font such as Times New Roman in a standard size (i.e., 12pt).
- Use only one space after concluding punctuation (such as a period).
- Do not include a title page. Instead, type your name, your instructor’s name, the course number, and the date at the top of your first page, flush with the left margin and double-spaced.
- Type the title of your paper above the body of the text. Center the title. Do not underline, italicize, boldface, type in all capital letters, or place in quotation marks. Capitalize all important words.
- Create a header with your last name and page number to appear on all pages. (Note: Your instructor may ask that you omit the name/page number header on the first page.)
- Print your paper on standard, white 8.5 x 11 inch paper.

How do I format my paper in Microsoft Word 2013?

Open a new Microsoft Word document

A new document automatically appears when Word is opened.

Create a new blank document

2. Single-click the Blank document option.

Shortcut Option: Press <Ctrl> + <N> in Microsoft Word to open a new blank document.
Set your margins to 1 inch

A margin is the empty space between a document’s contents and the edges of the page. Word’s default margins are 1 inch on each side of the page which is also the required margin for MLA. However, if the default is not 1 inch, you can easily adjust the margins.

1. Click the Page Layout tab on the Ribbon and click the Margins button in the Page Setup group.

A list of common page margins appears.

2. For 1 inch margins, select the Normal margin setting.

The margin setting is applied to the document.

Note: This is the normal default for margin spacing in Word 2013.

Set your line spacing and indentation

The default settings for Word 2013 do not match the MLA style requirements for line spacing and indentation, so you will need to make the following adjustments.

1. Click the Home tab on the Ribbon and click the Line Spacing button in the Paragraph group.

2. Click Line Spacing Options.

3. Make the following changes:

A. Change Indentation to First line by .5”.

B. Change After spacing to 0pt.

C. Change Line spacing to Double.
Create your header

In MLA style, the name of the author followed by the page number should appear at the right top margin in the header.

1. Click the Insert tab on the Ribbon and select Header from the Header & Footer group. Scroll down to the bottom of the list and select Edit Header.

2. Click on Home in the Ribbon and click on the Right Align tab.

3. Click on the green Header & Footer Tool Design box at the top of the screen.

4. Type your last name and press the space bar once.

5. Click the Page Number tab.
6. Slide your cursor down to **Current Position** and then over to **Plain Number**.

7. (OPTIONAL) If your instructor requested that you do not include the page number on the first page, check the box next to **Different First Page**. This will remove the page number from your first page.

8. Press the **Close Header and Footer** button in the ribbon and return to your paper.

---

### Enter name and course information

MLA style does not require a separate title page for research papers. Instead, place your name and course information in a double-spaced block below the header, along the top left-hand margin. This is called a report heading and it should only appear **on the first page of the document**.

1. Type your name on the first line below the header and press Enter.
2. Type the name of the instructor on the second line and press Enter.
3. Type the course name on the third line and press Enter.
4. Type the date on the fourth line and press Enter. MLA style requires the day-month-year (24 September 2014) format.

### Enter the Document Title

The title of your research paper should appear a double space below the name and course information, and should be centered between the page margins.
Jane Smith
Professor Taylor
English 105
16 April 2012

Ellington’s Adventures in Music and Geography

In studying the influence of Latin American, African, and Asian music on modern American composers, music historians tend to discuss such figures as Aaron Copeland, George Gershwin, Henry Cowell, Alan Hovhaness, and John Cage (Griffiths, Greenberg, and Olander 104-39). They usually overlook Duke Ellington, whom Peter Gammond rightly calls "one of America’s great composers" (318), probably because they are familiar only with Ellington’s popular pieces, like "Sophisticated Lady," "Mood Indigo," and "Solitude." Still little known are the many ambitious orchestral suites Ellington composed, several of which, such as The Liberian Suite and The Latin American Suite, explore his impressions of the people, places, and music of
In-Text References

What are in-text references and how do I use them? (214-232)

Within the text of your paper, you must show your reader exactly what you borrowed from each source you paraphrase or quote, and exactly where in the source you found the material. These are your in-text, or parenthetical, references.

Your in-text references point to sources in your list of works cited. Usually the author’s last name and a page reference is enough. If the work is listed by title, use the title, shortened or in full.

For a printed source, include the relevant page number or numbers. You may omit page numbers when you cite an entire work, an article on a single page, or if you cite an electronic source without pagination. Keep your in-text references brief. If you use the author’s name in a sentence, for example, you don’t need to repeat it in the parenthetical page citation.

An original passage from the book, *The Extreme Searcher’s Internet Handbook* (page 20) by Randolph Hock, published in 2009 by CyberAge Books is shown to the right, with examples of different types of in-text references.

Full citation:


Direct quotation:

“Knowing about the Deep Web is important because it contains a lot of tremendously useful information—and it is large. Various estimates put the size of the Deep Web at from 200 to 500 times the content of the visible web” (Hock 20).

Paraphrase with the author’s name in the text:

Hock (20) points out that the Deep Web is considerably larger than the visible web.

Direct quote with the author’s name in the text:

Hock (20) cites estimates of the Deep Web “at from 200 to 500 times the content of the visible web.”

Paraphrase with the author’s name in the parenthetical reference:

The content of the Deep Web is considerably larger than that of the visible web (Hock 20).
Indirect reference:

Sometimes, you will need to refer to an indirect quotation, that is, something that was itself a quotation in one of your sources. In this case, put the abbreviation \textit{qtd. in} (‘quoted in’) before the reference.

Joan London wrote of her father, Jack, “His longing for his daughters was deep and true, his need for them was desperate. But did anyone ever bungle more badly in trying to realize that desire? (qtd. in Labor 336).

This could also be written with both sources listed in the text.

Labor (336) cites Joan London as saying of her father, Jack, that “his longing for his daughters was deep and true, his need for them was desperate”

\textbf{You should only include the book, article or Web site that you actually have in your Works Cited.} In this example, Joan London would \textbf{not} be included in the Works Cited.

What is a Works Cited page? (126)

The *MLA Handbook for Writers of Research Papers* states:

Nearly all research builds on previous research. Researchers commonly begin a project by studying past work on their topics and deriving relevant information and ideas from their predecessors. This process is largely responsible for the continual expansion of human knowledge. In presenting their work, researchers generously acknowledge their debts to predecessors by carefully documenting each source, so that earlier contributions receive appropriate credit and readers can evaluate the basis for claims and conclusions.

As you prepare your paper, you should similarly seek to build on the work of previous writers and researchers. And whenever you draw on another’s work, you must also document your source by indicating what you borrowed—whether facts, opinions or quotations—and where you borrowed it from. Through documentation, you will provide your readers with a description of key features of each source (such as its authorship and medium of publication). Documentation also assists readers in locating the sources you used.

How do I format my Works Cited page? (37, 180-183)

The Works Cited page includes an *alphabetical* list of the sources you cited in your paper. You can see the *Using Citation Tools* section of this guide for instructions on how to build a Works Cited page in NoodleTools or Microsoft Word.

The page layout of your Works Cited page uses the same 1 inch margins, double-spacing, and header as the body of the paper. However, the page should be titled *Works Cited*, and the individual citations will use a hanging indent.

**How to create a hanging-indent in Microsoft Word 2013**

1. Place your cursor on the first line after the title, or highlight your citations if they are already typed.
2. Click the *Home* tab on the Ribbon and click the *Line Spacing* button in the Paragraph group.
3. Click *Line Spacing Options*.
4. In the *Indentation* area, select *Hanging by .5”* under *Special*. Be sure Left is also set to 0”
5. Press OK.
Works Cited


What pieces of information do I need to cite a book? (148-180)

- Author’s or editor’s name (last name, first name)
- Title of the book (italicized)
- City of publication
  - It is not necessary to include the state, province or country after the city name (151)
- Name of the publisher
  - Omit descriptive words, such as Books, House, Press, Publishers (247)
  - Example: Greenhaven Press should be listed simply as Greenhaven
- Always include UP for University Press
  - Example: Iowa State University Press should be listed as Iowa State UP (247)
- If the publisher’s name includes the name of a person, include only the person’s last name
  - Example: W.W. Norton should be listed as Norton (247)
- If the publisher’s name includes the name of more than one person, include only the last name of the first person in the group
  - Example: Harcourt, Brace & Jovanovich should be listed as Harcourt (247)
- Date of publication
- Medium of publication (Example: Print or Web)

It’s usually best to take this information from the title page of the book (front and back) rather than the cover.

Sometimes you will need to include additional information, such as the edition of the book or the specific pages you are citing.

How do I cite a book with one author? (148)


How do I cite a book with two or three authors? (154)


How do I cite a book with more than three authors? (154)


Note: “et al.” means “and others”
Note: You may also choose to list each author in the order in which they appear on the title page.
How do I cite a book with an editor? (153)


How do I cite a book with two or three editors? (154)


How do I cite a book with a corporate author? (156)


How do I cite a second or later edition of a book? (167)


How do I cite a multivolume work? (168)


Note: Use this format only when you used two or more volumes and you want to cite the entire work.

How do I cite an encyclopedia entry? (160)


Note: If the encyclopedia isn’t well-known, include full publication information.
How do I cite one chapter or section of a book? (157)


Note: This entry includes the page numbers of the chapter or section cited.

How do I cite more than one chapter or section of a book? (157)

Note: List each essay separately, followed by a cross-reference to the book (the editor's name and the page numbers). List the book itself in a separate entry, with complete publication information.


How do I cite a book found through Google Books? (187)


How do I cite a WILBOR book (eBook)? (187)

Articles

What is a periodical?

A periodical is any publication that appears on a regular basis, such as a daily newspaper, a weekly or monthly popular magazine, or a scholarly journal published three or four times a year. Articles from periodicals are excellent resources for student research projects.

What pieces of information do I need to cite an article? (136-148)

- The author's name (last name, first name), followed by a period
- The title of the article, followed by a period (in quotation marks)
- The name of the publication (italicized)
- The date of publication, followed by a colon (Day Month Year; abbreviate all months except May, June, and July)
- The page numbers of the article, followed by a period
- Medium of publication (Example: Print or Web)

Sometimes you will need to include additional information, such as a volume or issue number for a journal, or edition information for a newspaper.

Scholarly versus popular: what’s the difference?

Traditional popular materials include newspapers and magazines, such as The New York Times or Newsweek magazine. While these publications serve a very important purpose, instructors will often require students to use scholarly resources for their research projects. Journals are the most common place to find scholarly information. They include articles written by experts that are often reviewed and critiqued by other experts before they can be published. Because of this review by other experts in the field, it is common to hear the term “peer reviewed” in regards to scholarly publications.

How do I cite an article from a popular magazine? (142)


How do I cite a newspaper article? (141)


Note: 1 is the page number; A is the section of the paper. The plus sign indicates the article continues on an inside page.

Note: Omit beginning articles for newspaper titles. (Example: The Des Moines Register becomes Des Moines Register)

How do I cite an editorial in a newspaper? (146)

How do I cite an article in a scholarly research journal? (137)


Note: This citation includes the volume (77), issue number (2), and the year of publication (2006) instead of a specific date.

How do I cite an article ONLY available on the web? (190)


Note: Use inclusive page numbers; if not available, use n. pag.

How do I cite a book review? (144)

DMACC Library Databases

Is it a magazine, a journal, or a reference book?

The DMACC databases provide information from a variety of sources, including magazines, journals and reference books. It's important to distinguish which type of resource you are using.

Books will often include words like Encyclopedia, Dictionary or Survey in the title. A publisher is almost always provided. Many times you may see an “ISBN”, which is a code for the book. You may see phrases like, “In The Encyclopedia of…” Most of the entries in the Credo Reference and Magill OnLiterature Plus databases are from books.

Magazines and journal articles will not list a publisher. They will list a “source”, which is the name of the magazine/journal. It will include a date of publication, which is usually listed as a month and year (August 2012). Generally, you will also see a volume and issue, which may be identified, or may look like a decimal number (132.7). On newer articles, you may also see something called a “DOI.” This information is important in creating citations using the APA format.

What pieces of information do I need to cite an article from a database? (192-193)

Citations for articles and other documents from subscription services databases will normally include the same information you would have in a citation to a print source, with online access information added. The basic elements of a citation for an online article include the following:

- The author’s name (last name, first name), followed by a period
- The title of the article, followed by a period (in quotation marks)
- The name of the publication (italicized)
- The date of publication, followed by a colon, or volume, issue, and year information followed by a colon (Day Month Year; abbreviate all months except May, June, and July)
- The page numbers of the article, followed by a period
- The medium of publication (Example: Print or Web)
- The date you accessed the database

Sometimes you will need to include additional information, such as a volume number for a scholarly journal, just as you would when citing a print publication.

Examples from several of the subscription services available—through the DMACC libraries are included here.

Note: Some databases will try to provide ready-made citations for their resources. Be cautious with these, as many are not up to date with the latest set of MLA guidelines, and others often contain mistakes.
How do I cite an article from an EBSCOhost database (MasterFILE Premier, Academic Search Premier, etc.)?


How do I cite an article from a Thomson Gale database (Academic OneFile)?


How do I cite a report from the CQ Researcher database?


Note: in this citation, the name of the database is the same as the name of the publication.

How do I cite an article from a Proquest database (Des Moines Register)?

How do I cite an article from Project MUSE?


How do I cite an article from JSTOR?


How do I cite an article from the Credo Reference database?


How do I cite an article from a Facts on File database?

What pieces of information do I need to cite a Web site? (181-192)

Citations for other types of electronic sources may include any or all of the following:

- The name of the author, compiler, corporate author or editor of the work followed by a period
- **The title of the work**—italicized if the work is independent; in roman type and quotation marks if the work is part of a larger work
- The title of the overall Web site—if distinct from bullet point 2—(italicized)
- The version or edition
- The name of any sponsoring organization (If not available use N.p.)
- **The date of publication** (day, month and year, as available; if not available, use n.d.)
- **Medium of publication** (Web)
- **Date of access** (day, month and year)

In reality, many Web sites do not include all of this information. If you cannot find some of the information, cite what is available. Be sure to include at least the four elements in boldface type listed above.

In the past, website citations have required the inclusion of the site’s URL. However, tracking resources through a printed URL in a works cited list has proven challenging. URLs change frequently, and they are often so long and complicated that transcribing them correctly is very difficult. Since most resources can be easily found by searching for the title and/or author in a search engine, the MLA now recommends only including a URL when your resource may be difficult to find without it, or when your instructor requires it. If you include a URL, place it after your date of access and enclose it in angle brackets. If it does not fit on the line, break it only after the double slashes or a single slash. Do not hyphenate words to break your URL, as this only introduces confusion.

How do I cite an online dictionary or encyclopedia? (184)


How do I cite an online magazine? (184)

How do I cite an online newspaper? (184-187)


How do I cite an online news source (other than a newspaper)? (184-187)


How do I cite Wikipedia? (184-187)


Note: Use the square brackets to indicate that the information was not directly available. Find the approximate publication date in the page history tab on the Wikipedia page.

How do I cite a blog? (184-187)


How do I cite a podcast? (184-187)


How do I cite a YouTube video? (184-187)

How do I cite a general website? (184-187)


How do I cite presentation slides? (189)


How do I cite a book found through Google Book Search? (187-189)

How do I cite a government web site? (205-206)


How do I cite the *Occupational Outlook Handbook*?


How do I cite the *CIA World Factbook*?

Interviews

What pieces of information do I need to cite a personal interview? (201-202)

Citations for interviews you conduct with another person include the following:

- The name of the person you interviewed (last name, first name), followed by a period
- The kind of interview (Personal, Telephone, or E-mail interview), followed by a period
- The date you conducted the interview, followed by a period (Day Month Year; abbreviate all months except May, June, and July)

How do I cite a personal interview? (201)

Brandstad, Terry E. Telephone interview. 12 Sept. 2014.

Douglas, Laura. E-mail interview. 20 Sept. 2014.


What pieces of information do I need to cite a published or broadcast interview? (201-202)

Citations for published interviews include the following:

- The name of the person interviewed (last name, first name), followed by a period
- The title of the interview, if available. If it is not available, include the descriptive label Interview. You may include the interviewer’s name, if available.
- The name of the larger program, if available.
- The publisher’s information, date of publication, medium of publication, and date of access.

How do I cite a published or broadcast interview? (201)


What pieces of information do I need to cite an art work? (200-201)

Citations for original art works such as paintings, sculptures or photographs include the following:

- The name of the artist (last name, first name), followed by a period
- The title of the work (italicized), followed by a period
- The date the work was created (if known), followed by a period
- The medium of composition, if available
- The name of the institution that houses the work, such as a museum (or, for a work in a private collection, insert Collection of and the name of the person who owns it), followed by a comma. If the collector is unknown, use Private Collection with no name or city listed.
- The city where the work is located, followed by a period

If you are citing a photograph of a painting or sculpture, also include publication information for the source of the photograph, including the page, slide, figure or plate number, whichever is relevant. If your source is an Internet site, you will need to include the name of the site, the date you accessed it, and the URL.

How do I cite a painting, sculpture or photograph viewed in a museum? (200)


How do I cite visual art pictured in a book? (200-201)


Visual Art/Graphics

How do I cite visual art on the web? (189)


What do I need to know about citing graphics (graphs, charts, maps, etc.)? (202)

Visuals can be included in your text to help you convey information to your reader. Sometimes a chart, graph, or other graphic can enhance your document, but you should use visuals to supplement your text or content, not substitute for it. Always refer to a graphic in your text to show how it relates to the information you're communicating.

Examples of citations for graphics are included here.

How do I cite a chart or a map I found in a book? (202)


How do I cite a chart or a map I found on the web? (202)

How do I cite a cartoon from a newspaper? (202)


How do I cite a television or radio program? (193-195)


How do I cite a film or video, including YouTube? (197-198, 189-190)


How do I cite a sound recording (CD, cassette, record, mp3, stream from website, etc.)? (195-197, 189-190)


How do I cite a live lecture or presentation? (203)


How do I cite a personal letter or email? (204-205)

Smith, John. Letter to the author. 27 Aug. 2014. TS.

Instructor, Your. Memo to Students. Des Moines Area Community College, Des Moines. 27 Aug. 2014. TS.

Citation Tools

What is a Citation Tool?

Citation tools are software programs designed to perform part or all of the tasks involved in creating academic citations. Most tools are capable of at least creating your References page at the end of your paper. Some can also assist you with your in-text references. A few can even help you manage and organize your resources.

Should I Use a Citation Tool?

This is a complicated question. While citation tools certainly make the process easier, most individuals acknowledge that there is value in learning not only the pieces of a written citation, but also how it is constructed.

Many DMACC instructors want their students to have the opportunity to learn how to construct a written citation. These instructors do not allow the use of citation tools, and require that students create their own citations.

Other instructors, particularly in more advanced classes, believe that their students have already gained this foundational knowledge of how to construct a citation. These instructors typically see the use of citation tools as somewhat equivalent to using a calculator in a higher level math class. These instructors are typically “ok” with the use of a citation tool, as long as the student’s References list is correctly formatted.

Can My Instructor Tell If I Used a Citation Tool?

This depends a bit upon how the class is formatted. If you are simply submitting a final draft of a paper, all your instructor will see is whether or not your citations are correctly formatted. However, not all citation tools are particularly accurate, and instructors can always do an in-class test of your citation knowledge and creation skills.

How Accurate Are Citation Tools?

This is also a complicated question. Some of the citation tools are capable of producing highly accurate, detailed citations, provided that the information you enter is also accurate. Some citation tools are limited in the types and/or complexity of the citations they can produce. Many citation tools are poorly programmed and are incapable of producing accurate citations.

Ultimately, each student is responsible for the work he/she turns in. You should always double check your citations for accuracy and completeness.
Which Citation Tool Should I Use?

There are literally hundreds, maybe thousands, of citation tools available. Many are free; some require purchase or an on-going fee. Some tools have less powerful (and sometimes less accurate) free versions, as well as “upgraded” fee-based versions. Some instructors will tell you to use their favorite citation tool. In the end, you should use the tool that best meets your needs. In addition to helping you create citations the “old fashioned” way, the Library is able to assist you with both Noodle Tools and the Microsoft Word Citation Manager. For assistance with other citation tools, you will need to consult with your instructor or contact the service directly.

Noodle Tools

Noodle Tools is the preferred citation tool of most DMACC researchers. As long as the information entered into the Noodle Tools form is accurate, the software will produce an accurate citation. Noodle Tools asks the user to complete a form for each resource. These forms are then converted into a properly formatted Works Cited list. While the Noodle Tools knowledge base has extensive advice and information on how to properly construct in-text references, the software itself is only capable of producing the Works Cited list, which is placed at the end of a paper.

Mendeley

Mendeley is more of a source manager than a citation tool. It offers the most robust citation tool currently available. As a result, it is probably best suited for advanced users, who are collecting, storing and organizing large numbers of documents. In addition to producing highly accurate, detailed citations, Mendeley offers a Microsoft Word plug-in which fully integrates into Word 2013. This plug in corrects nearly all the errors produced by the “basic” Microsoft Word Citation Manager. This eliminates the need for the corrections listed at the end of this document. Mendeley can also save most citation data directly from library databases, Web sites, etc. Mendeley can be accessed at http://www.mendeley.com and does require the installation of a desktop application. Up to 2Gb of information can be stored for free. Additional storage is available for purchase.

Microsoft Word Citation Manager

Some DMACC users prefer the ease of an integrated citation tool, like the Microsoft Citation Manager. The data form for recording sources can be clunky, and Microsoft doesn’t always follow the rules. This means that citations need to be corrected before submitting them for a grade. Many students find this process confusing and stressful. (A list of required corrections is included at the end of the section that addresses using Word 2013 for citations.)
What is NoodleTools?

NoodleTools is an online tool that can help you format your bibliography page and allows you to save and organize the references for books and articles used for your research assignments. It is accessible from home and campus through the DMACC library website. For further assistance, contact a DMACC librarian.

You can access NoodleTools through the DMACC library website. Click on the link for NoodleTools under Research Help.

If you are a first-time NoodleTools user, click on the “Create Personal ID” button to get started.

Creating an account in NoodleTools is beneficial for two reasons:

1) You can begin your list now and come back to it later, no matter where you are or what computer you are using.

2) You can create more lists in the future, as you continue your studies at DMACC and have additional research projects.
You will need a “School/Library Password” to access the sign in page. Ask your librarian for the password.

Once you enter the password you will see a “New User Registration” form. Fill out the form by answering the questions and creating a Personal ID of your choice. You may use anything you would like for your username, as long as someone else hasn’t already selected it. We recommend using your DMACC username.

If you forget your username/password, please see your campus librarian.
Approximately once a year, Noodle Tools will ask you to “revalidate” your account. This simply re-assures Noodle Tools that you are still connected to DMACC, and authorized to use their services. If you receive the revalidation screen, please see your campus librarian for the necessary information.

Once you have created your Personal ID, you can start entering references by creating a new project. Each research project you are working on should have its own list. Start by clicking on the “Create New Project” button at the top right hand side of the page.
Next, select your citation style and level. Be sure to choose “MLA” and “Advanced” options. Enter a name for your project in the description box. Click “Create Project” at the bottom of the page to get started.

You may name your project anything you like, but we recommend that you include the topic of your project, the course and semester. E.g. Gun Control Comp II Spring 2013.

The next screen is called the Dashboard. Here you can work on many aspects of your project: your thesis statement, your research question(s). You can also share your project with a teacher or librarian to receive assistance and/or feedback.

You can set up and maintain a “To Do” list of tasks you still need to complete for your project. You can use Noodle Tools to create digital notecards and your outline.

To access your Works Cited list, click Works Cited, located in the Components group.

While Noodle Tools provides a link to Google Docs, we recommend that you use Microsoft Word to write your paper. Word is available on most computers on campus, and can be purchased at any DMACC bookstore for use on your computer at home.
One of the options Noodle Tools makes available is the ability to make your projects Web sites that can be viewed by others, or if you desire, copied by others. This is the “Public View” setting. Once you select to make your project publicly available, Noodle Tools will give you a URL (Web address) for your project that you may then share with others.
Once you have clicked on “Works Cited” under “Components on your Dashboard, you are ready to begin entering the information for each of your sources.

Create each citation for your Works Cited list by selecting a citation type from the drop down menu. The most common citation types used by DMACC students are journals and books. Ask a librarian for help if you need assistance figuring out what citation type is needed for your source.

Once the citation type is selected, click the “Create Citation” button to continue.

Noodle Tools will give you the option of viewing a slide show on the selected resource type. This can be useful if you are unsure. An example might be if you are debating between journal and magazine.

When you are ready, click “Continue” at either the top or bottom of the screen.
Complete the form with the available information for your resource. Be sure to select the correct format of your resource from the tabs at the top of the form. If you decide you have selected the incorrect resource type, you may make changes from the drop down boxes at the top of the screen.

As you select each text box, Noodle Tools will give you instructions for the correct entry of your data. If you make a mistake, Noodle Tools will display an exclamation point inside of a yellow triangle.

Once you have clicked on “Submit” to complete a resource, Noodle Tools will return you to the main Works Cited screen. To enter another resource, simply select the resource type from the drop down and begin the process again.

Once you have reached the main Works Cited screen, your work has already been saved to the Noodle Tools server. Please do not try to save your work to another source. (e.g., a flash drive, your p:\ drive, etc.)
After you have entered all of your sources and completed your paper, review each of your citations on the main Works Cited page for errors. You are ready to print your Works Cited page. Click the “Print/Export” button and then select “Print/Export to Word”.

You can edit your citations by clicking “Edit” from the options on the right-hand side of the screen.

Once you see the pop-up for Microsoft Word, click “Ok”. Your Works Cited page will open in a new Microsoft Word window.
Noodle Tools will always open your Works Cited in Times New Roman, 12pt font. Double check and make sure that the font matches what’s on the rest of your paper. Also, be sure to add a header with your name and the correct page number. Please see a DMACC librarian if you need help with getting the correct page number added.

Since Noodle Tools saves your work to their server, and keeps track of any changes to your list, we recommend that you wait and print your Works Cited at the very end of your project. This will help eliminate confusion and mistakes between what you may have saved and what Noodle Tools has saved.
You can also use Word 2013 to create and manage a References page as you write the text of your research paper. Word will keep track of the bibliographic information you supply as you assemble your sources. You can choose to enter all of your sources at the beginning of your project, or enter them as you write the text of your paper. You will only need to enter the basic information once. After that, Word will store the information and you can use it as many times as you need.

It is a little different workflow than NoodleTools, so let your librarian know if you need additional help.

Here’s how to get started citing sources in Word 2013:

Select a citation style

Choose MLA from the drop-down menu under the References tab.

Enter a new source

For each new source, follow these steps:

1. Place the cursor in the body of your paper where you need to insert an in-text reference. See the section of this guide devoted to In-Text References for more detailed information.

2. Click the References tab, then click the Insert Citation button in the Citations & Bibliography group.

3. Select Add New Source

4. Enter the source information in the dialog box. You may need to click the “Show All Bibliography Fields” box to show more than just the recommended fields. Even so Word does not have fields for some required information like the DOI for an electronic article. These will need to be added manually to your citation list.

5. Click OK. An in-text reference is inserted in the document where the cursor is located. The source is also saved, so it can be cited again in the document and included in the References list.
Cite an existing source

To use a source you have already entered, follow these steps:

1. Place the cursor in the body of your paper where you need to insert an in-text reference. See the section of this guide devoted to In-Text References for more detailed information.

2. Click the References tab, then click the Insert Citation button in the Citations & Bibliography group.

3. Select the source from the drop-down list.

Generate your Works Cited page

When you are finished typing your paper and entering your sources, you can automatically generate a Works Cited page that presents all the sources in the correct format and layout, according to MLA rules.

To create your Works Cited page from previously saved sources, follow these steps:

1. At the end of the text of your paper, add a new page by pressing <Ctrl + Enter> OR click Blank Page on the Insert tab

2. Click the References tab and click the Bibliography button in the Citations & Bibliography group.

3. Select Bibliography and then select Works Cited to insert the list of sources for your Works Cited page.
Formatting your Works Cited

Caution: Word 2013 does not always automatically follow the formatting guidelines of MLA style. Once you have added your list of sources to your Works Cited page, be sure to check the following formatting concerns:

1. Change the color of the words “Works Cited” to black, and resize it to match the rest of your paper. Use the Center align button to center it between your margins.

2. Highlight all of your citations, then right click and choose Paragraph. Change the line spacing to Double and set Spacing Before and After to 0 pt.

3. Verify each citation to verify that the citation style displays correctly. The following examples demonstrate common issues that occur in citations generated in Word 2013.
Corrected Works Cited Page

**Formatting a citation for a book:**

Enter a book into Word 2013 Citation Manager as a **Book**. Word 2013 may format your citation like this:


You will need to add the word **Print** followed by a period to comply with MLA format


**Formatting a citation for a chapter from a book:**

Enter a chapter from a book into Word 2013 Citation Manager as a **Book Section**. Word 2013 may format your citation like this:


You will need to make the following changes to comply with MLA format:
- Reverse the order of the first editor’s name (from Hernon Peter to Peter Hernon).
- Add the word “Print” to the end of your entry, followed by a period.


**Formatting a citation for a book with two or more editors:**

Enter a book into Word 2013 Citation Manager as a **Book** and place the editor’s names in the **Editor** field rather than the **Author** field. Word 2013 may format your citation like this:


You will need to make the following changes to comply with MLA format:
- Add eds. after the comma following the final editor’s name.
- Add the word “Print” to the end of your entry, followed by a period.

Formatting a citation for an ebook:

Enter an ebook into Word 2013 Citation Manager as a Book. Word 2013 may format your citation like this:


You will need to make the following changes to comply with MLA format:

- After the copyright date, add the title of the Web site or database in italics.
- Add the word Web followed by a period after the title of the Website or database.
- Add the date you accessed the site. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2007 should appear as 25 Apr. 2007.


Formatting a citation for an article from a popular magazine:

Enter an article into Word 2013 Citation Manager as an Article in a Periodical. Be sure to enter the date using the standard abbreviations for months. Example: April should appear as Apr. Word 2013 may format your citation like this:


You will need to add the word “Print” to the end of your entry, followed by a period to comply with MLA format.


Formatting an article from a newspaper:

Enter a newspaper article into Word 2013 Citation Manager as an Article in a Periodical. Be sure to enter the date using the standard abbreviations for months. Example: April should appear as Apr. Word 2013 may format your citation like this:


You will need to add the word “Print” to the end of your entry, followed by a period to comply with MLA format.

**Formatting a citation for an article from a scholarly journal:**

Enter an article into Word 2013 Citation Manager as a *Journal Article*. Word 2013 may format your citation like this:


You will need to add the word “Print” to the end of your entry, followed by a period to comply with MLA format.


**Formatting a citation for a magazine article from a database:**

Enter an article into Word 2013 Citation Manager as an *Article in a Periodical*. Be sure to enter the date using the standard abbreviations for months. Example: April should appear as Apr. Word 2013 may format your citation like this:


You will need to make the following edits to comply with MLA format:

- After the page number(s), add the name of the database in italics.
- Add the word “Web” after the name of the database, followed by a period.
- Add the date you accessed the site. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013.


**Formatting a citation for a journal article from a database:**

Enter an article into Word 2013 Citation Manager as a *Journal Article*. Word 2013 may format your citation like this:


You will need to make the following edits to comply with MLA format:

- After the page number(s), add the name of the database in italics.
- Add the word “Web” after the name of the database, followed by a period.
- Add the date you accessed the site. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013.

**Formatting a citation for a Web site:**

Enter a website into Word 2013 Citation Manager as a Web Site. Word 2013 may format your citation like this:


You will need to make the following edits to comply with MLA format:

- Change the title of the Web page (Academic Freedom) from italics to inside quotation marks
- Italicize the name of the larger Web site (National Education Association)
- Insert the name of the publisher as producer, which in this case also happens to be the National Education Association. Use standard abbreviations for this section, which can be found on pages 234-256 of the *MLA Handbook.*
- Since there is no copyright or publication date listed on this website, use n.d. after the publisher’s name
- Add the word Web after the date or n.d.
- Add the date you accessed the site. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013


**Formatting a citation for an interview:**

Enter the interview into Word 2013 Citation Manager as an Interview. Be sure to enter the date using the standard abbreviations for months. Example: April should appear as Apr. Word 2013 may format your citation like this:

Branstad, Terry. Interview. 12 Apr. 2014.

You will need to add the type of interview conducted (Personal Interview, Telephone Interview, Email Interview, etc.) to comply with MLA format:

Formatting a citation for an article from Wikipedia:

Enter the article into Word 2013 Citation Manager as **Book Section**. Enter Wikipedia as both the name of the book and the publisher. Word 2013 may format your citation like this:


You will need to make the following edits to comply with MLA format:

- Wikipedia entries do not often contain copyright dates, or dates of last update. Check the history tab to find the date of the last edit of your article. Place the date of the last edit in square brackets, since you retrieved this information indirectly (not from a formal copyright statement)
- Add the word Web after the date of publication.
- Add the date you accessed the article. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013


Formatting a citation for a video from YouTube:

Enter the video into Word 2013 Citation Manager as **Web Site**. Word 2013 may format your citation like this:


You will need to make the following edits to comply with MLA format:

- Insert the name of the larger Web site in italics directly after the title of the video
- Move the date of publication to directly after the name of the publisher (YouTube as well, in this case)
- Insert the word Web after the date of publication
- Add the date you accessed the video. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013

Formatting a citation for an article from a newspaper Web site:

Enter an online newspaper article into Word 2013 Citation Manager as an Article in a Periodical. Be sure to enter the date using the standard abbreviations for months. Example: April should appear as Apr. Word 2013 may format your citation like this:

Dolamge, Dave. "Learnapalooza Sparks Students' Interest in Learning." Des Moines Register 2013 Apr. 21

You will need to make the following edits to comply with MLA format:
• Insert the name of the website (DesMoinesRegister.com) after the title, in italics and followed by a period.
• Change the title of the newspaper from italics to regular text.
• Add the publication date after the title of the newspaper and separate with a comma. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013
• Insert the word Web after the publication date.
• Add the date you accessed the article. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013.


Formatting a citation for a government Web site:

Enter a government web site into Word 2013 Citation Manager as a Web Site. Word 2013 may format your citation like this:


You will need to make the following edits to comply with MLA format:
• If no individual author is listed, cite the government agency that issued the document as the corporate author.
• Add the name of the Web site (U.S. Census Bureau) in italics directly following the title of the article or page.
• Add the government agency after the name of the Web site.
• Add the word Web after the publication date.
• Add the date you accessed the site. Use the format Date Month Year, with standard abbreviations for months. Example: April 25, 2013 should appear as 25 Apr. 2013.

This document was adapted from the following DMACC resources:

- *Documenting Sources: A Brief Guide to MLA Style for DMACC Student Writers* (© 2013)
- *Word 2007: MLA FAQs*
- *Instructions for Creating a Research Paper: MLA Style*
- *Getting Started with NoodleTools: an Introductory Guide using MLA*

Additional information and examples from: